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1. Introduction

This Deployment Guide will guide the installer through the process of installing, configuring, and adding a
SmartControl 12 (§SC-0012) controller.

Before You Begin
Read through this document in its entirety and ensure that the following required items are available:

SMartControl 12 (SSC-0012) CONTIOIEY ... ettt ettt st e sttt e s e st e sae et e eeestesreennd I:l
Unique ID (UID) Of the CONTIOIEE ..ottt sttt ettt be st seetesre s esestennane s I:l
(located on the bottom of the unit)

Savant Host (Smart or Pro Host) licensed and running da Vinci 7.0 or higher ......cccocovvveviecccneiennnn l:,
Savant Development Environment (SDE) MaACBOOK® ...ttt ste s ene e ane e I:l

(with RacePoint Blueprint da Vinci 7.0 or higher installed)

Ethernet network meeting Savant reQUIrEMENTES ...ttt ere e I:l
(see Network Requirements)
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2. Deployment Steps Checklist

Follow these steps to successfully deploy the SmartControl 12 (SSC-0012) controller.
This page can be used as a checklist to record which steps have been completed.

1.  Review the SSC-0012 Connections and CONTIOIS ...t D
See SmartControl 12 Overview

2. MOUNE CONEIOIIEI ottt b et ettt ere e b et ene et et eseebe b ensabe b eseesesbennaresns D
See Installation

3. Wire Controller to Savant Control SYStEM ... D
See Wiring and Connections

4. Add the SSC-0012 to a RacePoint Blueprint configuration.........ccccoceeiveeiiiicceiceecececeeed D
See RacePoint Blueprint Configuration

5. Upload Configuration to Savant HOSt ...t D
See Upload Configuration
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3. SmartControl 12 Overview

Box Contents and Specifications

Refer to the Quick Reference Guide for this product located on the Savant Customer Community for Box
Contents and Specifications

Front Panel

SAVANT

Status

Press and hold for 5 seconds while powered On to clear network

R t Butt . . . . .
@ eset Button settings. Status LED will blink rapidly when reset is complete.

Blinks Once: No IP Address

Blinks Twice: Waiting for Host Connection
Status LED Blinks Three Times: Host Connection Lost

Solid: Connected to Host
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Rear Panel

RELAY

NC/C1/N¢ NC/C2/NO

Ethernet

12 YDC

-4+ -5+ -6+ G 1 2 G PDIPD2

10/100 Base-T auto-negotiating port with Link/Activity LEDs:
@ Ethernet 8-pin RJ-45 female.
See items B and C for LED functionality.

Off: Ethernet link is not established.
Link LED Green Solid: Ethernet link is established.
Green Blinking: Ethernet activity is occurring.

Off: 10 Mbps data rate

@ Data Rate LED Green: 100 Mbps data rate

Used to transmit and receive serial binary data to and from RS-232
@ RS-232 controllable devices. Ports 1 & 2 support CTS/RTS handshaking. 8-pin
RJ-45 female. See RS-232 Pinouts.

Used to send IR signals to control devices with an IR input or IR receiver
via an IR flasher (5V tolerant only). 6-pin Screw Down Plug-in

@ Connector. See IR Wiring for important precautions regarding IR
functionality before making any connections.

GPIO (General Purpose Input and Output Ports)- 6-pin Screw Down Plug-in Connector.
See GPIO Wiring for pinouts.

When configured as an input, the processor will look for a low (<0.8V
() GPIO Input DC) or high (>2.4V DC ) state.
Minimum OV DC / Maximum 12V DC

When configured as an output, the port provides a binary output of

GPIO Output 0-12V DC 150mA max.

Normally Open / Normally Closed - Relays
6-pin Screw Down Plug-in Connector

@ Dry contacts (open/closed) to control devices requiring basic on/off
Relay operation. DC Voltage Max: 30V DC 1A.
6-pin Screw Down Plug-in Connector
@ Input Power 12V DC 1.6A - Connect to included power supply.
@ Cable Lance Use with included cable tie to secure power supply connection.
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4. Installation

The SSC-0012 should be located in a place that is dry, well ventilated, and out of direct sunlight.

Mounting Plate Installation

A mounting plate (074-0577-xx) is supplied with the SSC-0012 controller. This mounting plate is used to mount
the controller to a wall or existing structure. To mount the controller, follow the instructions below.

1.  Position the mounting plate onto the wall where the controller will be located. Position the bracket so the tabs
that hold the controller are positioned horizontally.

2. Mark the two mounting holes on the wall.

Install wall anchors and sc

9

rew mounting plate to the wall.

4. Snap the SSC-0012 controller into the bracket so the tabs on the mounting bracket seat into the slots on the

side of the controller.

Controller

—_—
i%:"

- T

m Mounting
Bracket [

\__ﬁ?—w

Rack or Cabinet Instal

lation

When mounting in a rack or cabinet, the controller should be set on a solid, flat, level surface.

The next step is to connect the required ports. Refer to the Wiring and Connections section below.
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5. Wiring and Connections

Refer to the diagrams below when making connections.

Power and Ethernet

Wi-Fi
Network  )Cat5/5e/6

Ethernet

Smart or Pro Host

Power Supply

1.  Connect RJ-45 Cat 5/5e/6 Ethernet cable from Ethernet port to the local network switch.
2. Plug the supplied power supply from the 12V DC port to a 120V AC surge protected outlet.

RS-232 Connections

The SmartControl RS-232 connections are used to transmit serial binary data to a device for control and receive
serial binary data from devices to display current status on the user interfaces. Each port type can support
multiple protocols that are determined by the logical connection within Blueprint.

Savant recommends planning control connections and protocols to be used prior to building any cables and
connecting equipment. This will ensure that devices will respond to commands and will not be damaged by an
incorrect cable configuration.

RS-232 Pinouts

PinT: - Pin 5: RXD (RS-232)
Pin2: - Pin 6: TXD (RS-232)
Pin3: --—-— Pin7: CTS (RS-232)
Pin 4: GND (RS-232) Pin8 RTS (RS-232)

- Pins 7 & 8 are only required for CTS/RTS handshaking.

- Wire coloring is included to identify the pins used for this

connection. Colors shown do not represent any wiring standard.
RJ-45 Connector

Gold Pins Facing U,
¢ aUp) AIMPORTANT! When wiring to this port, DO NOT connect any
wires within the cable that are not required for communication.

RJ-45 to DB9 Adapters

Savant uses RJ-45 connectors for RS-232/422/485, other manufacturers devices may use the standard DB9. To
make connection easy, Savant offers RJ-45 to DB9 adapters in a variety of configurations that can be used for
RS-232/422/485 control. Be sure and choose the adapter that provides a proper connection to the devices
RS-232/422/485 port. Refer to the manufacturer’s support documentation for the devices configuration.

For more information on Savant RJ-45 to DB9 adapters, refer to the RS-232 Conversion to DB9 and RS-422/485
Pinout application note located on the Savant Customer Community.

A IMPORTANT!
If you are using RJ-45 to DB9 adapters not supplied by Savant:

« Ensure that any wires required for communication/control are terminated within the adapter.

« Ensure that all wires NOT required for communication/control are NOT terminated in the connector.

« Ensure that the unused wires in the connector are cut to prevent them shorting out, as they are still terminated in
the RJ-45 connector on the controller side.
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IR Wiring

IR connections are made using 6-pin Screw Down Plug-in Connectors supplied with matrix or receiver. The wire
slips into the hole and locks screw located at the top of the connector.

A IMPORTANT! IR Wiring Precautions

« Ensure that all IR emitters are within 15 feet (4.6 meters) from the controller’s location.

« Use of 3rd party flashing IR emitters with Talk Back is not recommended. These types of emitters can draw voltage
away from the IR signal that can degrade IR performance.

IR Connector Pinout

1. IR1-
2:IR1+
3 IR2-
4:1R2+
5 IR3-
6:IR3+

Use White Stripe
for Positive (+)

GPIO Wiring

General Purpose Input/Outputs (GPIO) are binary /O ports used on Savant controllers to trigger an action within
the system. Events can control a device, such as turning on an amplifier (output) or detecting a state change for a
device (input) to perform a workflow. Pins 1-4 are used for input or output depending on configuration.

GPIO Pull Down Resistor (PD) Usage (Option)

The GPIO pins are by default configured as inputs and pulled high to +12V while the host is booting up. To pull the
GPIO signal low during a host reboot and/or power cycle, a jumper wire can be connected between a GPIO pin
and its corresponding PD1 or PD2 pin. Doing this adds a Tk ohm resistor between the GPIO pin and ground which
keeps the GPIO output below 0.8V while host is rebooting.

1. GND
l - G)PE”PDZ 2: GPIO1 « Add jumper between GPIO 1and PD1 to pull the
| L 3 GPIO 2 GPIQ1 pin low while host is rebooting.
I‘ I I‘ I I * Add jumper between GPIO 2 and PD2 to pull
4: GND the GPIO 2 pin low while host is rebooting.
N OO D)7 5. PDI
l | 6: PD2
GPIO 1 GPIO 2 Using
Standard PD2 Jumper
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Relay Wiring
Relays are used when a contact closure (normally open or normally closed) is needed to activate a device such as
raising or lowering shades, opening or closing a gate, etc.

RELAY
NC/C1/NO NC/C2/NO 1 NC (R1)
2.C1 RY)
3 NO (R1)
245l v ®
5:C2 (R2
6: NO (R2)

NC = Normally Closed
C = Common

Use a white stripe ~ NO = Normally open
for NC or NO

Making Connections

1.

2.
3.

© ® N O

Remove Power if power is applied.

Pull to remove the terminal block from the rear of the controller.

With a small flat bladed screwdriver, turn the screws on the top of connector counterclockwise until the silver
crimps in the front of the connector opens enough to slide the wire into the square slot.

Insert one of the stripped wires from the device being controlled into its respective slot in the connector. Refer

to the diagrams above.

Turn the screw clockwise until the screw tightens around the wire. Tug on the wire a bit to verify it is installed
securely. Do not allow more than 1/2 inch of stripped wire exit from the rear of the connector.

Repeat for each wire till all wires are installed in that connector.
Repeat steps above for all connectors as required.

Plug terminal blocks back into rear of the controller.

Reapply power.
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6. RacePoint Blueprint® Configuration

Add the SmartControl 12 controller to the configuration.

1.  From the RacePoint Blueprint menu bar, open the Component Library.
View > Show Component Library.

2. Enter SSC-0012 in the search box.
3. Select the SSC-0012 from the Component Library and drag it into one of the zones/rooms.
Note: Controllers are typically added to the Shared Equipment Zone but not required.

4. Drag the SSC-0012 into the RacePoint Blueprint layout window. If using an existing configuration, remove the
component that the SSC-0012 is replacing.

5. Select the SSC-0012 and open the inspector.
View > Show Inspector

6. Enter the SmartControl 12 Unique ID (UID) for the SSC-0012 being used in the system. In order to be
recognized by the Host, the UID located on the bottom of the SmartControl 12 is required within Blueprint.

800 Inspecting “Savant Extender"

@ Edit [ Device [screens| [ Hide Details |

513 (
oco ]

Class: Savant Extender
Manufacturer: Savant
Model: SmartControl 12

Device Name: | sayant Extender
Savant |

+

®

J«——— Enter Savant Unique ID (UID)

Notes:

[O]

Show: | Data I/0s al @

Data connector:  Ethernet (Ethernet)
Name on Component: Ethernet (Ethernet)

Direction: Input

| —| [ Show user defined properties |
7. Close the Inspector
8. Connect the Ethernet port of the SSC-0012 to the local network device.

Savant Extender e
oco |
Network Device 5]
¥ Control Ports
- IR(Serial PWM) Output 1 ! £
IR{Serial PWM) Output 2 [ral B
IR(Serial PWM) Output 3 [l B
v Assigned Data IR{Serial PWM) Output 4 s B}
w Port 1 IR(Serial PWM) Output & [ B}
. @ Ethernet Port (Ethernet) IR{Serial PWM) Output & s B}
v Port 2 RS232 1 (RTS/CTS) -
@ Ethernet Port (Ethernet) RS232 2 (RTS/CTS) L3
¥ Port 3 Relay NO/NC 1 D
@ Ethernet Port (Ethernet) Relay NO/NC 2 1
v Port 4 GPIO 1 @:
@ Ethernet Port (Ethernet) GPIO 2 (1a]
v Port 5 ¥ Data
@ Ethernet Port (Ethernet) [ ]

9. If any of the Control Ports on the SSC-0012 are to be controlling other equipment, the profiles for these

devices can be found in the RacePoint Blueprint Component Library. Add this equipment and connect to the
appropriate Control Port (RS-232, IR, Relay, GPIO).

Refer to the Relay and General Purpose Input/Output Profiles Application Note - 009-0482-xx on the
Savant Customer Community for details on using these profiles.
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7. Upload Configuration
After the SSC-0012 has been added to Racepoint Blueprint and the configuration is complete, it needs to be
uploaded to the host.
1.  Save the configuration.
Select File > Save from the Blueprint menu bar.

2. Select the Generate Services icon in the Blueprint toolbar. The State icon on the Blueprint toolbar will change
to green indicating the services for the configuration were created.

3. To upload the configuration, select the Upload to Master icon from the Blueprint toolbar and send the
configuration to the host.

o) e ozl B B 0 & N

State Generate Services Update All Ul Screens  Show Library Show Inspectol Upload to Master | View SRS View Services Review Service Prefs Review Triggers Manage Logins Manage Lighting

L Select Upload to Master

4. In the Configuration must be saved dialog window that opens, read the dialog and select Save and Upload.

Configuration must be saved.
The configuration has unsaved changes. Save the
configuration before uploading to the Control

System?

| Cancel | || Save and Upload ]]

5. The System Monitor application will automatically open as shown below. Verify the path to the configuration
file is correct. Select Upload when satisfied.

System Monitor - Scanner

b PN 7

(s
Review Clear Upload Upgrade

= )

Sync themes Cancel Upload Address Version
15.220.134  7.2.2:7564

Scanner
/Users/ savant.user /Documents/_2016_Projects/SSC-0012/Smari  Browse

5 2 results ?

6. The configuration will now upload to the host. Once uploaded, the Savant Pro or TrueControl Il App can now
be opened and connected to the host.
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8. Additional Documentation
Additional documentation is available on the Savant Customer Community.
« SmartControl 12 Smart Controller (SSC-0012) QRG - 009-1255-xx

. Relay and General Purpose Input/Output Profiles Application Note - 009-0482-xx
« Savant Controllers Family video in the Savant University pages
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Appendix A: Document Revision History

009-1268-01 - February 2016
Section Update

« Removed Specifications Table

* Updated Power Supply specifications

¢ Added Upload Configuration section

¢ Updated RacePoint Blueprint Configuration section

Rear Panel

009-1268-00 - November 2014

Section Update

All Initial release of this Deployment Guide
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Network Requirements

Savant requires the use of business class/commercial grade network equipment throughout the network to ensure
the reliability of communication between devices. These higher quality components also allow for more accurate
troubleshooting when needed.

Connect all Savant devices to the same local area network (LAN) or subnet as the host. Savant recommends not
implementing any type of traffic or packet shaping in your network topology for the Savant devices as this may
interfere with performance.

Network Configuration

To ensure that the IP Address will not change due to a power outage, a static IP Address or DHCP reservation
should be configured. Savant recommends using DHCP reservation within the router. By using this method, static
IP Addresses for all devices can be managed from a single Ul avoiding the need to access devices individually.

Setting DHCP reservation varies from router to router. Refer to the documentation for the router on how to
configure DHCP reservation.

Network Changes

Savant recommends performing one of the following steps to refresh the IP connection after connecting to a new
network, changing routers, or if the IP Address range is changed in the current router. This will reset any IP
connection and ensure that the SSC-0012 is communicating with the network correctly.

To Reboot the Controller:
« Cycle Power
Disconnect the controller from the AC power source for 15 seconds and then reconnect.

« Hot Plug the Ethernet (LAN) Connection
Disconnect the Ethernet (LAN) connection from the controller for 15 seconds and then reconnect.
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Important Notice

Disclaimer

Savant Systems, LLC. reserves the right to change product specifications without notice, therefore, the
information presented herein shall not be construed as a commitment or warranty.

Savant Systems, LLC. shall not be liable for any technical or editorial errors or omissions contained herein or for
incidental or consequential damages resulting from the performance, furnishing, reliance on, or use of this
material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign
patents.

All products and services are trademarks or registered trademarks of their respective manufacturer.

Copyright

This document contains confidential and proprietary information protected by copyright. All rights reserved.
Copying or other reproduction of all or parts of this document is prohibited without the permission of Savant
Systems.

Trademarks

© 2016 Savant Systems, LLC. All rights reserved. Savant, Savant App, Savant Host, Now You Can, RacePoint
Blueprint, Single App Home, TrueCommand, TrueControl, and the Savant logo are trademarks of Savant Systems,
LLC.

AirPlay, Apple, AirPort Express, AirPort Extreme, Apple TV, Apple Remote Desktop, FireWire, iMac, iTunes, iPad,
iPad mini, iPad Air, iPhone, MacBook, Mac and OS X are trademarks or trade names of Apple Inc. iOS is a
trademark of Cisco®. Android, Google, Google Play, and other Google marks are trademarks of Google, Inc. Wi-Fi
is a registered trademark of the Wi-Fi Alliance®. HDMI® is a trademark of HDMI Licensing, LLC.

All other brand names, product names, and trademarks are the property of their respective owners.

Technical Support
Savant Systems, LLC is dedicated to providing prompt and effective support in a timely and efficient manner.

« To contact Savant Support, access the Savant Customer Community and enter a support Case ticket.

- To contact Savant Sales, visit Savant.com and select Contact Us to locate a local sales representative in your
area.
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